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SURPAC Google Earth Linear and Graphic Functions
Google Earth allows for the viewing of 2D or 3D colour satellite imagery for any point on the Earth,
as well as being able to view galaxies and the ocean floors. The surface terrain imagery can usually
be viewed at a scale in the region of 1:2500 without any loss of detail quality. This figure can vary
from region to region, but it is generally true for built up areas.
Google Earth, therefore, makes a vary useful visual display tool for SURPAC Users when it is
interfaced, or linked, with survey co-ordinate and/or image data. This interfacing can be in the form
of :Displaying the locations of Trig. Beacons and/or Town Survey Marks for a selected area.
Displaying Beacons and Stations from a previous survey to help locate these points.
Displaying User selected Points in a Co-ordinate file to help locate these points.
Displaying Points and/or Lines from a survey plan, or sheet, to view their positions.
Displaying a survey Plan, or Sheet, itself as an overlay image on the earth surface, etc.
Importing a Placemark created in Google Earth into SURPAC.
Importing a Line, Path or Polygon created in Google Earth into SURPAC.
Importing a Google Earth Image into SURPAC.
Requirements to enable SURPAC interfacing with Google Earth
1. Google Earth must be installed on the computer. If you do not already have Google Earth
installed, visit http://earth.google.com/ and follow the on-screen instructions for installing this
software. The basic version of Google Earth is free and is quite suitable for the SURPAC
interface functions discussed below. There is the option of the Google Earth Pro version, but
at a cost of US$400 (about R2,500).
2. The currently loaded Co-ordinate file in SURPAC must use either the WGS 84 ellipsoid, the
GRS80 ellipsoid or any other ellipsoid having the same parameters as the WGS 84 ellipsoid.
3. A reasonably fast ADSL or 3G wireless internet connection.
Optional Setting the Google Earth Display of SURPAC Data and Overlays
1. The SURPAC data displayed on Google Earth does not always provide an exact visual fit on
to the satellite imagery. In order to force the displayed data to fit as close as possible to the
imagery, you can use the Google Earth Ruler tool to determine the Y, X (or E, N) shifts to be
applied to the SURPAC data, or image, so that it best fits the imagery.
2. A plan, or sheet, that is displayed on Google Earth as an overlay can have varying levels of
transparency applied to it. Increasing an overlay’s transparency allows more of the imagery
lying under the overlay to become visible. Setting a zero transparency will allow the overlay to
completely hide the underlying imagery. Note that on Google Earth itself there is a “slide”
option (on the Sidebar information display) that allows for further refinement of the overlay’s
transparency level.
3. An overlay of a plan, or sheet, may also be viewed whereby the sheet background is
completely transparent, i.e. only the detail on the sheet, such as the lines, text, hatching etc.
will be displayed. For this option to apply, the sheet background colour has to be white, which
is the case for all SURPAC CAD sheets.
4. Line information sent from SURPAC to Google Earth can have the following options :Users can set the Lines to be sent using their defined Line Thickness values.
Users can set the Lines to be sent using their defined Line Colour values.
If Lines are to be sent using a Single Colour, then this colour can be User defined.
All SURPAC CAD programmes which use the Google Earth display function have a menu item
whereby the Google Earth display option can be set or viewed. The options may also be set by
clicking the [File options] button when in the “Co-ordinate File Editing” programme.
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Displaying the “Locate and Add Nearest Trig/TSM Beacons” beacons on Google Earth
1. In SURPAC run the Locate and Add Nearest Trig/TSM Beacons programme from the
Conversions main menu heading (if your SURPAC License has this Module).
2. Set the search options at the bottom of the form so as to display the required number and
type of beacons.
3. From the displayed list of beacons, remove any unwanted beacons by clicking on the green
tic shown at the end of each display line. The green tic will change to a red cross. This point
will remain “dormant” and will not be displayed until clicked again.
4. Click on the [View List on Google Earth] button at the bottom right of the form.
SURPAC will open and run Google Earth and the selected beacons will be displayed at their
surface positions on the satellite imagery. Either a Trig. Beacon or a TSM symbol (icon) will be
used to mark the displayed beacons. To obtain a beacon’s information, click on the beacon
required. A balloon text display will then appear showing :The Beacon Name
The Degree Square (Trig Beacons only)
The Co-ordinate System (e.g. WG29°)
The Beacon Y, X and Z values (or E, N and H values)
The Beacon Latitude and Longitude

Example of a 3D View of Trig Beacons displayed on Google Earth
Displaying selected Points from the Co-ordinate File on Google Earth
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1. In SURPAC, run the Co-ordinate File Editing programme from the General main menu
heading.
2. Mark (i.e. highlight) the Points required for viewing on Google Earth.
2.1 You can mark a block of Points by either clicking on the first Point in the block and then
dragging the cursor onto the last Point, or by clicking on the first Point in the block then
holding down the Shift key and simultaneously clicking on the last Point in the block.
2.2 You can mark individual Points by clicking on the first required Point and then, whilst
holding down the Ctrl key, click on any other required Points.
2.3 You can mark Points by Description by clicking on the [File Options] button and then
selecting the Select Points to be Highlighted (by Description) option. Then select the
required Descriptions from the displayed list.
3. After selection, Click the [Export GE KML] button on the Actions Bar menu.
The Points selected will be displayed at their surface positions on the satellite imagery by Google
Earth. Either a Point, a Trig. Beacon or a TSM symbol (icon) will be used to mark the displayed
Points, as is appropriate. To obtain a Point’s information, click on the Point required. A balloon
text display will appear showing :The Point Name
The Point Description
The Co-ordinate System (e.g. WG29°)
The Beacon Y, X and Z values (or E, N and H values)
The Beacon Latitude and Longitude

Interfacing SURPAC CAD programmes with Google Earth
These functions apply to the General CAD, Contour CAD, General Plan CAD, Sectional Title
CAD and Working Plan CAD programmes.
Note that the Contour CAD programme only has the Viewing a SURPAC CAD Sheet on
Google Earth option available.
Viewing a SURPAC CAD Sheet’s Lines and Points on Google Earth
Note :Before proceeding, view and/or reset the Google Earth options in SURPAC (see above).
If the Point Display option is On, then only the Points that have been Named (by using the
[PN] Command) will be displayed on the Google Earth overlay.
All Lines will be shown in the User selected style, width and colour. Refer to Paragraph 4 of
“Optional Settings” on Page 1.
All Points will be marked by either the SURPAC Point marker or, in the case of Trig. Beacons
and TSMs, the appropriate control point symbol.
1. In the CAD programme, click on the “File” main menu heading and then select the View
Lines and Points on Google Earth menu item. (Note :- If the Point Display has been turned
Off, then this menu item will read View Lines on Google Earth).
2. Once the CAD sheet Line and Point data have been transferred, Google Earth will shift its
location to the centre of the imagery covered by the data and will display the data viewed from
an appropriate height. The Orientation is set to North and there is no Tilt applied. All viewing
settings can be User modified from within Google Earth. Clicking on a displayed Point will
show a text balloon containing the Point’s values and information.
.
Page 3 of 26

Keith W. Young (Pty) Ltd.
Developers and Suppliers of SURPAC Surveying Software

Example of a new township layout, showing Lines and Named Points, on Google Earth
Viewing a SURPAC CAD Sheet on Google Earth
Notes :Before proceeding, view and/or reset the Google Earth options (see above).
One problem associated with using a CAD Sheet as an overlay is that of the Meridian
Convergence. Since a CAD Sheet is always oriented to Grid North (the True North at the
Central Meridian of the projection) and not to True North at the Sheet position, SURPAC has
to swing the CAD Sheet display so as to re-orient it to True North.
Before the image of a CAD Sheet is sent to Google Earth as an overlay, you will notice it
being re-drawn in SURPAC. This is to both re-orient the Sheet for Meridian Convergence, as
explained above, and to set the Sheet scale to the defined plotting scale. This latter action is
too ensure a clearer Sheet image on Google Earth. For the Windows Vista operating system
(which has better graphic memory handling), the scale is set to half the defined plotting scale
to provide an even clearer overlay image.
1. In the CAD programme, click on the File main menu heading and then select the View Sheet
on Google Earth menu item.
2. Once the CAD sheet has been transferred, Google Earth will shift its location to the centre of
the imagery covered by the Sheet and will display the Sheet viewed from an appropriate
height.
Notes :The Sheet Orientation is set to True North (regardless of the Sheet Swing used) and there is
no Tilt applied. All view settings can be User modified from within Google Earth.
The Sheet overlay will be “locked” to the terrain covered by the Sheet. Hence, when viewed in
3D, the Sheet will drape itself over the terrain, much like a table cloth laid over a piece of
rocky ground. If the Sheet background has been set as fully transparent (see Google Earth
Options), then only the Sheet data, such as Lines, Text, Hatching etc .will be shown.
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Otherwise, the Slide on the Google Earth Sidebar can be used to change the Sheet overlay
transparency.

Example of a SURPAC Township layout Sheet, with partial transparency, on Google Earth

Example of a layout with full background transparency, on Google Earth
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Example of a 3D semi-transparent CAD Sheet Overlay, plus Trigs on Google Earth

File type used for Interfacing SURPAC with Google Earth
Interfacing with Google Earth is done via KML files (Keyhole Markup Language). KML files
employ HTML/XML type grammar and may be used for modelling and storing geographic
features such as points, lines, images, polygons and models for display in Google Earth, Google
Maps, ESRI ArcGIS Explorer, AutoCAD etc.
Once you have defined which elements (points, lines, map sheets etc.) you want displayed on
Google Earth, SURPAC will transform the Y, X (or E, N) positional information into Latitudes
and Longitudes. SURPAC will also convert dotted or dashed lines into small line segments for
sending to Google Earth, as the KML format can normally only handle solid lines.
If a SURPAC CAD sheet is to be sent to Google Earth, SURPAC will first set the sheet
transparency, or set the background to fully transparent (as User set) and then create a PNG
image of the sheet. (PNG (Portable Network Graphics) files are lossless, highly compressed
image files, normally having the extension of .png.)
All SURPAC generated KML and PNG files are stored in the folder “C:\Surpac_GE”. The names
of the generated KML files (and of the associated PNG files, where applicable) are :KML files saved from the “Locate and Add Nearest Trig/TSM Beacons” programme are
called FileName_Trigs.kml, where FileName is the name of the current Co-ordinate file.
KML files saved from the “Co-ordinate File Editing” programme are called
PointName_Point_Group.kml, where PointName is the name of the first Point selected
(marked) in the current Co-ordinate file.
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KML files saved for Lines and Points from the “General CAD” programme are called
FileName_CAD_Lines.kml, where FileName is the name of the current Co-ordinate file.
KML and PNG files saved for Sheet overlays from the “General CAD” programme are called
FileName_CAD_Sheet.kml and FileName_CAD_Sheet.png, where FileName is the name
of the current Co-ordinate file.
KML files saved for Lines and Points from the “General Plan” programme are called
FileName_GP_SheetX_Lines.kml, where FileName is the name of the current Co-ordinate
file and X is the current GP Sheet number.
KML and PNG files saved for Sheet overlays from the “General Plan” programme are called
FileName_GP_SheetX.kml and FileName_GP_SheetX.png, where FileName is the name of
the current Co-ordinate file and X is the current GP Sheet number.
KML files saved for Lines and Points from the “Working Plan” programme are called
FileName_WP_SheetX_Lines.kml, where FileName is the name of the current Co-ordinate
file and X is the current WP Sheet number.
KML and PNG files saved for Sheet overlays from the “Working Plan” programme are called
FileName_WP_SheetX.kml and FileName_WP_SheetX.png, where FileName is the name
of the current Co-ordinate file and X is the current WP Sheet number.
KML and PNG files saved for Sheet overlays from the “Contour CAD” programme are called
FileName_Contour_Sheet.kml and FileName_Contour_Sheet.png, where FileName is the
name of the current Contour file.
Compressed (zipped) KMZ files for third party use
Another file format that can be used for sending data and overlays to Google Earth is the KMZ
format. This is a zipped format of a KML file and is a handy format when sending overlay
information to another person who does not have SURPAC Software.
To create a KMZ file from a SURPAC generated KML file, use any zip application, such as
Winzip, or WinRAR to create a zipped file that contains all the required elements for the data and
or overlay. The created zip file must be given the extension .kmz
Notes :1. For files that contain Points, you must include the three small PNG image files called
RedBlackTrig.png, RedBlackTSM.png and RedBlackPoint.png.These images are the
SURPAC mark icons for Trigs, TSMs and Points respectively.
2. For overlays that consist of a CAD Sheet, the PNG image of the CAD Sheet must be
included. The PNG image file will have the same name as the KML file.
3. All the above files, including the KML file, are located in the “C:\Surpac_GE” folder.
The KMZ file can then be sent to a third party user, with the instruction that the contents of the
KMZ file must be extracted to a folder called “C:\Surpac_GE”. Unzipping (extracting) the KMZ
file will produce the parent file with a KML extension, plus the mark icons, and other information
linked to the KML file. Double clicking on the extracted KML file will then open Google Earth and
produce the same data and/or overlay view as produced by SURPAC.
Hints when using SURPAC CAD and Google Earth interfacing
1. If you intend to view multiple SURPAC data and/or overlays in Google Earth, then do not
close Google Earth after each viewing. Leave Google Earth in the background, or
minimize it, whilst you generate the next view.
2. If you have multiple views displayed, any of these may be temporarily removed by unchecking their display names in the Temporary Places section.
3. When you do close Google Earth, you will be queried as to whether you want to save the
temporary view in the My Places section. If you want the views to be permanent, then
reply “Yes”, otherwise they will be deleted.
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Transferring a Google Earth Placemark position to a SURPAC Co-ordinate File.
Creating a Placemark in Google Earth
In Google Earth, ensure that either the Toolbar or the Sidebar are displayed. Move the Google
Earth display to show the required area at the required scale.
To create a Placemark, click the appropriate toolbar icon, or select the "Placemark" menu item
found under the "Add" menu heading. The new Placemark Dialog Box appears and the cursor
changes to a flashing, square drawing tool. Enter the properties for the Placemark and give it an
appropriate Name. Since SURPAC will use the Placemark Name as the name for the imported
Point, use a SURPAC friendly name, i.e. up to 8 characters in length.
Move the cursor onto the flashing drawing tool, and then drag the tool to the required screen
position, by holding down the Mouse LHB as the cursor is moved. Once the drawing tool is
correctly positioned, click the [OK] button on the dialog box. The newly created Placemark will be
added to My Places. (Warning, if you have a Temporary Place currently open at the time of the
construction, then the Placemark may be added to that Temporary Place).
The created Placemark now needs to be saved as a KML file in order for SURPAC to be able to
import it. To do this, locate the Placemark under either My Places or Temporary Places and
right click on it. A pop up menu will appear and on this menu click the Save Place as … menu
item.
On the displayed Save file … form, ensure that the Save as Type item is set to KML (*.kml). The
KML file may be saved to any folder, but SURPAC KML files are generally kept in the
C:\Surpac_GE folder. Finally, click on the [Save] button.
Importing the Placemark into a SURPAC Co-ordinate File as a Point
Before attempting to import the Placemark data into a Co-ordinate file, first ensure that the file
System is set to either the WGS 84 or GRS80 ellipsoids and that the Central Meridian of the WG
System, or Zone, is correct for the Point data to be imported.
In the SURPAC Co-ordinate File Editing programme, click on the [Import GE KML] button on
the Actions bar menu.
From the displayed File Selection form, select the KML file that contains the required Placemark
information. The Placemark position(s) will then be converted to its(their) equivalent Y, X (or E, N)
co-ordinate values and saved into the current Co-ordinate file, using the Placemark name(s) as
the new Point name(s).

Transferring a Google Earth Path, Line or Polygon to a SURPAC General CAD Sheet
Creating a Path or Polygon in Google Earth
In Google Earth, ensure that either the Toolbar or Sidebar are displayed. Move the Google
Earth display to show the required area at the required scale.
A Path may be a single Line, or a series of connected Lines. To create a Polygon, click the
appropriate toolbar icon, or select either the Path or the Polygon menu item found under the Add
menu heading. The new Path or new Polygon Dialog Box appears and the cursor changes to a
square drawing tool. Enter the properties for your drawing and give the Path or Polygon an
appropriate Name. You can change the style and/or colour for the line or polygon from the default
white to better visualize the shape you are about to draw. You can also enter an appropriate
Name for the Path or Polygon to be created.
Click in the viewer to start the drawing creation and use the following method to achieve the
desired shape :Regular shape - Click and release method. Move the Mouse to a new point and click to add
additional points. In this mode, the cursor remains a square drawing tool whilst the Path or
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Polygon being drawn is displayed up to the last clicked position. Polygons will automatically be
closed back onto the defined starting position. Whilst drawing, the last clicked position can be
deleted by clicking the Mouse RHB.
Once construction of the Path or Polygon is complete, click the [OK] button on the dialogue box.
The Path or Polygon created will be added to My Places. (Warning, if you have a Temporary
Place currently open at the time of the construction, then the Path or Polygon will be added to
that Temporary Place).
The created Path or Polygon information now needs to be saved as a KML file in order for
SURPAC to be able to import it. To do this, locate the Path or Polygon under either My Places or
Temporary Places and right click on it. A pop up menu will appear and on this menu click the
Save Places as … menu item.
On the displayed Save file … form, ensure that the Save as Type item is set to KML (*.kml). The
KML file may be saved to any folder, but SURPAC KML files are generally kept in the
C:\Surpac_GE folder. Finally, click on the [Save] button.
Importing the Path or Polygon into a SURPAC General CAD Sheet
In the SURPAC General CAD programme first set the required Pen Style, Colour and
Thickness to be used for the imported lines. Click on the File menu heading and then select the
Import Lines from Google Earth KML File menu item . From the displayed File Selection form,
select the required KML file. The Lines contained in the selected KML file will be imported and
displayed on the current Sheet, using the defined Style, Colour and Thickness.
NB : The same importation method can be used to import Line information from a SURPAC (and
compatible) generated KML file containing Lines from sources such as other General CAD
Sheets, General Plans, Working Plans and Sectional Title Plans.

Transferring a Google Earth Image to a SURPAC General CAD Sheet
Creating an Image Bounding diagonal Line (Path) and defining an Image in Google Earth
In Google Earth, ensure that the Toolbar and Sidebar (found in the Layers Panel) are
displayed. Move the Google Earth display to show the required area at the required scale.
Click the Google Earth “Tools” menu heading and select Options…. Select the 3D View tag and
then set the Show Terrain option to OFF. (This is important. If Google Earth is viewed using the
Terrain option as ON, images become distorted due to terrain height variations.)
Use the Navigation Control (displayed at the top right corner of the Google Earth display) to set
the orientation to True North (click the N symbol at the top of the Navigation Control). (This is
also important. If Google Earth is not viewed in True North orientation, the image will be distorted
when sent to SURPAC.)
Tips
In order to be able to select the full image displayed, click on the Google Earth View menu and
ensure that the Status Bar is not displayed.
To maximise the image area, click on the Google Earth View menu and ensure that the
Sidebar is not displayed.
With the Google Earth image oriented to True North and the Terrain option turned off, create a
Path (as described above) consisting of a single line, by carefully clicking on the top left and then
the bottom right corners of the Google Earth display area.
Save this Path as a KML file (as described above), normally into the C:\Surpac_GE folder.
NB : After creating and saving this Path, it is important that the Google Earth display is not
changed in any way until the current image has been saved.
Click on Google Earth’s File menu heading, then select the Save menu item and then the Save
Image sub-menu item. In the Save As dialogue box, enter an appropriate file Name. The file type
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is automatically set to the Jpeg format. Save the file in the same folder as the associated Polygon
(normally the C:\Surpac_GE folder).
NB : The Google Earth Pro application is able to create image files at a higher resolution than the
standard Google Earth. However, the Pro version is not free and costs about US$400.
Importing the Google Earth Image to a SURPAC General CAD Sheet
In the SURPAC General CAD programme ensure that the sheet size and scale are correct for the
Image to be imported. Then import the Image bounding diagonal line via the Path KML file
created above (which defines the Image size and position - see above) by using the Import Lines
from Google Earth KML File menu item.
On the CAD Sheet, locate the cursor at the approximate centre of the Polygon, then click the
Mouse RHB. Click the Image menu heading and then select the Add (Import) a Sheet Image
menu item. On the Image Selection form, set the required path and then click on the required
Image file. On the right hand side of the form deselect the Maintain the Image Width and Height
Ratio option and select the Apply Meridian Convergence to Image option.
NB : This last setting is important as it is necessary for SURPAC to apply a small rotation to the
incoming Image to compensate for Meridian Convergence. This due to the Google Earth
Image being oriented to True North and the SURPAC Image being oriented to the Grid
North (i.e. the True North at the central meridian).
The Sheet will automatically be re-oriented by the amount of the Meridian Convergence. On the
SURPAC General CAD Sheet, move the cursor to the top left terminal of the imported Path (or
Line) and then click the Mouse LHB. Now move the cursor to the bottom right terminal of the
imported Path and then click the Mouse RHB.
SURPAC will now apply a swing to the Image to correct for the Meridian Convergence. The Sheet
will again re-orientate back to 0° and display the adjusted imported Image.
NB : The Image may not fit exactly onto the Path terminals, due to the former having been swung
to compensate for the Meridian Convergence
Adjusting the Imported Sheet Image
Setting the Image to the Background – If the Image lies on top of existing Line and Text items
then set the Image as the background, i.e. the Lines, Text, Points etc. will be displayed on top of
the Image. To do this, right Click on the Image, click the Image menu heading and then select the
menu item Send Images to the Back.
Shifting the Image - The imported Image may need to be shifted in the Y and/or X directions to
get a good fit with any existing Sheet data. If this is required, right Click on the Image, click the
Image menu heading and then select the Shift a Sheet Image menu option. On the displayed
form, enter the Y and/or X movement required for the Image. This option can be repeated to
ensure a good fit.
Adjusting the Image Brightness and/or Contrast – Images required for background information
may need their brightness and/or contrast adjusted to avoid the Images interfering with the
display of Lines and Text. To do this, right Click on the Image, click the Image menu heading and
then select either of the Adjust Image Brightness or the Adjust Image Contrast menu options.
On the displayed form, use the slide bars to set the required brightness and contrast values.
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SURPAC Google Earth Elevation Functions

These SURPAC Google Earth functions make use of the importation of height data interpolated via
the Google Earth Elevation API. This function allows for the interpolation of heights of locations
anywhere on the Google Earth DTM.
Summary
Based on tests carried out on data samples in areas in South Africa, it would appear that the
interpolated Google Earth heights are, in general, accurate to about 3 - 4 metres. This figure can be
improved to below the 2m level, however, by carrying out a comparison between surveyed ground
heights and Google Earth derived heights for selected points in an area, and then adjusting the
interpolated Google Earth heights for the mean area height difference. These results must be seen as
estimates and might not be applicable in your area. This can best be tested by using ground control
points for comparison. Nearby standard Trigonometrical Beacons can also be used for ground control
(bear in mind that the Beacon height is the top of the pillar, which is usually 1.4m above ground level).
Applications
Generating Contour and DTM files via downloaded Google Earth data provides rapid and useful data
that have various small scale applications. When displayed in conjunction with an imported Google
Earth image, these become even more useful. The generated Contour and DTM files can also be
exported as KML files for client viewing directly on Google Earth itself. Examples of useful
applications are for : Township planning approval
 Sub-divisional planning approval
 Preliminary water/gas/fuel pipe alignment over long distances
 Preliminary road/rail alignment over long distances
 Cross section data for preliminary mass haul calculations
 Preliminary dam site investigations (water volume versus wall height etc.)

1. Co-ordinate File Editing Programme
1.1 Import Points from a KML file – This existing function has been extended so as to allow the
import of multiple Points contained in a KML file, and not just a single Point as was the case
previously.
1.2 Importing interpolated Google Earth DTM Heights – This function allows you to import
interpolated heights from Google Earth for any, or all Points existing in the current Co-ordinate
file. You may define the entire file, or mark (highlight) selected points in the file. Heights will
only be imported for points whose current heights do not exist. Existing heights will not be
overwritten.
Using this Option :
If you want to restrict the import of heights to selected Points, then first highlight these Points in
the Co-ordinate file listing. You can highlight Points by :I. Highlight a block of Points by clicking on the first Point and then dragging the mouse
cursor to the last required Point, or
II. Highlight a block of Points by clicking on the first Point and then, holding down the
[Shift] keyboard key, click on last required Point.
III. Highlight selected Points by clicking on the first Point then, holding down the keyboard
[Ctrl] key, click on any other Points required.
Then, in the Actions Menu, click on the [File Options] menu item to display the File Options
form. The Google Earth options are at the bottom of this list of options. Click on Import
interpolated Google Earth Heights and then click on the [OK] button. If you have highlighted
a set of Points, you will be prompted if you want to restrict the height importation to these
Points. Reply as appropriate.
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Heights for the selected Points, or for the entire file will now be imported via interpolation from
the Google Earth DTM and displayed on the Co-ordinate file listing. These height importations
are relatively slow and are imported at a rate of approximately 50-80 Point heights per minute,
depending on your internet connection. speed. The maximum Point heights that may be
imported are restricted by Google Earth to 2,500 per day.
1.3 Compare Existing heights with interpolated Google Earth Heights – This function allows
you to compare existing Co-ordinate file heights with interpolated heights from the Google
Earth DTM. You can define the entire file, or mark selected points in the file. This function is
useful when needing to evaluate the accuracy of imported Google Earth Heights against
surveyed values.
Using this Option :
If you want to restrict the comparison of Google Earth heights to selected Points, then first
highlight these Points in the Co-ordinate file listing as explained above. Then, in the Actions
Menu, click on the [File Options] menu item to display the File Options form. Click on
Compare File and Google Earth Heights and then click on the [OK] button. If you have
highlighted a set of Points, you will be prompted if you want to restrict the height importation to
these Points. Reply as appropriate.

A form will be displayed in which the selected Points, their co-ordinates, description, surveyed
heights and interpolated Google Earth heights will be shown. These height comparisons are
imported at a rate of approximately 350-500 Point heights per minute, depending on your internet
connection. Statistical data relating to the comparison of heights are shown at the bottom of the
form.
There is also an option whereby you can compare Google Earth heights for a single, User selected
Point.
Using this Option :
In the Co-ordinate file display, right click on the Point whose height you want to compare. On
the “pop up” menu that will now be displayed, select the menu item Compare Height with
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Google Earth. A form will then be displayed showing the Point selected, its co-ordinates and
height, the Google Earth height and the difference. Moving the cursor away from this form will
cause it to be removed.

2. Tacheometric File Editing Programme
The main and most important function regarding the importation of Google Earth 3D data is the
generation of Tacheometric files, using data solely imported via Google Earth interpolation, as
explained below.
2.1 Import Points with interpolated Google Earth Heights – This routine allows you to import
Point co-ordinates, along with their interpolated heights, from the Google Earth DTM. Points
are imported over a User defined quadrilateral figure covering the required area, plus a User
defined Grid interval.
Using this Option :
In the Actions Menu, click on the [Import GE Data] menu item. The form below will be
displayed, allowing you to enter the four points used to define the required quadrilateral. The
named Points should exist in the current Coordinate file, otherwise their co-ordinates must be
entered manually.

To ensure that the quadrilateral covers the correct area, these 4 Points are best determined by
using Google Earth to create Placemarks at the appropriate positions. The quadrilateral does
not have to be square, nor does it need to be oriented NS or EW. Any four Points that enclose
the required area are sufficient. One restriction is that, when entering the 4 Points into the
above form, they must be entered in a clockwise sequence, normally starting at the Point that is
approximately the NW corner.
SURPAC will then proceed to calculate Tacheometric file points along the perimeter lines of the
quadrilateral, as well as on all Grid intersections lying within the quadrilateral, using the defined
Grid interval. Once all points are calculated, their heights are interpolated from Google Earth
and all point data are added to the file. These Tacheometric points are imported at a rate of
approximately 350-500 Points per minute, depending on your internet connection.
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SURPAC Contour CAD, showing imported Google Earth Points on a 50m Grid
This generated Tacheometric file can then be used in the SURPAC Contouring CAD
programme to construct and edit contour lines (using the Triangulation method) over the
quadrilateral area, in the usual way.
The two preceding images and the one on the next page show the stages of generating a
contour display from imported Google Earth points, i.e. defining an area, importing the data,
creating the Contours and then displaying these contours on Google Earth via a KML file.

SURPAC 5m Contours of Hartebeespoort dam wall area using Google Earth Data
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2.2 Compare Existing heights with interpolated Google Earth Heights – This function allows
you to compare existing Tacheometric file heights with interpolated heights from the Google
Earth DTM. .
This function is useful when needing to evaluate the accuracy of imported Google Earth
Heights against surveyed values.
Using this Option :
In the Actions Menu, click on the [Compare GE Hts]. A form will be displayed in which the file
Points, their co-ordinates, description surveyed heights and interpolated Google Earth heights
will be shown. These height importations are imported at a rate of approximately 350-500 Point
heights per minute, depending on your internet connection. Statistical data relating to the
comparison of heights are shown at the bottom of the form.

3. Contour Generating CAD Programme
3.1 Compare existing heights with interpolated Google Earth Heights – This function is the
same as that described Tacheometric File Editing Programme, above.
Using this Option :
3.1.1 Comparing a Single Point
Right click on the Spot Height that is to be compared and then, from the Spot Heights menu
heading, select Compare Spot Height with Google Earth Height (for a single Point). A form
will then be displayed showing the Point selected, its co-ordinates and height, the Google Earth
height and the difference. Moving the cursor away from this form will cause it to be removed.

3.1.2 Comparing the entire file
Click on the Spot Heights menu heading and select Compare Entire File with Google Earth
Heights. A form will be displayed in which the Tacheometric file Points, their co-ordinates,
description, surveyed heights and interpolated Google Earth heights will be shown. These
height comparisons are imported at a rate of approximately 350-500 Point heights per minute,
depending on your internet connection. Statistical data relating to the comparison of heights are
shown at the bottom of the form.
3.2 View 3D Contours & DTM on Google Earth – Once all the contours have been generated
and edited, using the Surface Triangulation method, you can view the contours alone, or the
contours and the solid 3D model created from the surface triangulation in situ on the Google
Earth surface.
Using this Option :
Click on the File main menu heading and then select View Contours & DTM on Google Earth
menu option.
On the displayed form, first read the help information by clicking on the [?] icons, to see the
implications and use of the available options, especially with regard to the two Surface
Options. These options allow for the display to be “clamped to the Google Earth “ surface, or
to have it shown as a free standing 3D model. The former method would be used for Contours
that represent the natural earth surface and the latter for both Contours and DTMs of manmade
features such as stockpiles, dumps and earthworks.
NB : Google Earth will not display any imported KML data that lie below its own surface.
Trying to display an excavation, for example, is not possible if the excavation Contours and
DTM lie below the natural surface.
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SURPAC 3D Triangulation Model and Contours displayed in situ on Google Earth
In the above example, the “Show Display in 3D over the Google Earth Surface” was used. This
mode is necessary for physical manmade features, such as dumps or stockpiles, that overlay
the pre-existing natural surface.
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SURPAC 3D Triangulation Model and Contours of a slimes dam survey, viewed in situ on
Google Earth
Summary on displaying 3D Models in Google Earth
In Google Earth it is possible to view imported and superimposed KML data from various view
ports. This can be done dynamically using the Mouse, as follows : Panning – Hold down the Mouse Left Hand button and move the cursor in the desired
direction.
 Scaling – Scroll the mouse scroll wheel forwards or backwards.
 3D Object Viewing – Move the cursor to the centre of the object, then hold down the
Mouse Middle button. Moving the cursor forwards or backwards will change the Tilt (vertical)
view point. Moving the cursor left or right will change the Orientation (horizontal) view point.
The amount of vertical height exaggeration can be set in Google Earth by clicking on the
Tools menu and selecting the Options… menu item.
The following image of Table Mountain shows superimposed 20m contours, generated in
SURPAC from data imported from Google Earth. The KML display uses the “Clamp to
Google Earth Surface” option. As this covers a large area and a large number of points (a 50m
grid was used), the data had to be imported in two sessions.
Google Earth will only allow the downloading of 2,500 “locations” per user per day. As
SURPAC collects data at a rate of 4 points per location, this maximum daily limit is increased to
10,000 points. For areas that require more than this limit, separate the area into two or more
sections and download the data on consecutive days (or just use a different e-mail addresses if
you have them!)
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SURPAC 20m Contours of Table Mountain using Google Earth interpolated Data

4.

Longitudinal Sectioning Programme
A new function has been added that allows for the generation of Longitudinal Sections by the
direct importation of interpolated Google Earth Heights.
Using this Option :
Click on the [Set File Type] menu item in the Actions Bar menu. On the displayed form, select
the “Section Plotting Using a LONG-SECTION File only” option and Click the [OK] button.
Click on the [Select a File] menu item in the Actions Bar menu. From the displayed form,
enter the new File Name and Click on the [Open] button.
Once the “Long Section Creation/Editing” form is displayed, Click on the [Options] button.
From the displayed list, select the “Generate Sections from defined Bend Points and
Google Earth Heights” option and then Click the [OK] button.
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A form will then be displayed that allows you to enter the Bend Points that define the required
Long. Section. These Points must exist in the current Co-ordinate File.
NB : An easy way to import a series of Bend Points is to define a Path in Google Earth that
follows the required route. This Path can then be imported into the SURPAC General
CAD programme. After this, use the option that Converts Line terminals into Points.
The [Y, X] values of these Points will then be stored in the Co-ordinate File. Finally, use
the Co-ordinate File’s “Import interpolated Google Earth Heights” option to height these
Bend Points.
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Once all Bend Points have been entered, select the required Interpolation Interval for the
section and then Click the [Proceed] button.

A SURPAC Long Section through Lion’s Head, Table Mountain and Devil’s Peak, using a Path
and Heights imported from Google Earth
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Displaying Bench Marks on Google Earth (Locate and Add Nearest Bench Marks)
Using this SURPAC programme, it is possible to display selected Bench Marks on Google Earth

The “Locate and Add Nearest Bench Marks” programme display

Display of Bench Marks on Google Earth, showing information for a selected Bench Mark
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Drawing Arcs, Circles and Dashed/Dotted Lines on Google Earth
The KML language used to generate KML files on Google Earth only provides for limited line drawing
options. Available options are line width and line colour and apply to straight lines only.
SURPAC has always provided for line styling (dotted lines, dashed lines etc.) by means of adding
extended functions to handle such lines.
The SURPAC General CAD programme enables the plotting of Arcs and Circles on Google Earth
via a KML file. Arcs may be solid, dotted or dashed.

Example of a SURPAC KML file displayed on Google Earth, including Arcs and Circles

Creating KML Placemarks & Polygons with linked Images and Files
SURPAC is able to create Google Earth KML files for both Placemarks and Polygons that have
attached Images or, Files, or both. When the Placemark or Polygon is displayed on Google Earth,
clicking on its icon will display locality information, hypertext Links to files and the Images included for
the Placemark, or Polygon.
The Image Placemarks (this wording is used to differentiate form standard Placemarks) are created
via the Co-ordinate File Editing programme, and the Image Polygons (again to differentiate from
standard Polygons) are created via the General CAD programme. Both programmes are found under
the SURPAC General main menu heading.
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Image Placemarks can be useful for : Defining the Point’s position on the earth’s surface.
 Using an image or a sketch plan to clearly show the physical location of a Beacon, Reference
Mark, Trig. Beacon or Town Survey Mark.
 Using an image to display a surveyed point of interest, such as a monument, grave stone,
sewer or geographical feature.
 Using a Link file to describe an important surveyed feature or point of interest.
Image Polygons can be useful for : Defining the position, shape and size of the Polygon on the earth’s surface.
 Showing images of site itself from various viewing positions.
 Showing images of important geographical features on the site.
 Showing images of existing infrastructure or development on the site.
 Using Link files defining the Polygon/site dimensions and legal documents pertaining to the site,
such as a Diagram or Deed of Transfer etc.
Although the KML files for both Image Placemarks and Image Polygons are created individually, all
such files in a folder can be combined into a single KML file. Sending the information to a third party,
then requires just sending the sub-folder (see below) created by SURPAC, as this sub-folder will
contain all the necessary KML files (including the combined KML file), as well as the image and link
files used in each of the KML files.

Creating KML Image Placemarks in SURPAC
When in the Co-ordinate File Editing programme, right click on the display line for the Point for which
an Image Placemark is to be created. This will cause the normal pop up menu to be displayed, which
now includes the new menu item Create a Google Earth Image Placemark.

Set up form for a Google Earth Image Placemark or Image Polygon
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The above form will be displayed, with its heading showing the folder Path that will be used to store the
Image Placemark/Polygon information and the Point or Polygon Name.
NB : SURPAC will create a sub-folder under the main SURPAC - Google Earth folder (called
“C:\Surpac_GE”). This sub-folder is created from the name of the current Co-ordinate file. All
blanks in the file name will be replaced by underscores. In the above example, the folder used to
store the information is “C:\Surpac_GE\8140bgpwg84”, and the Polygon name is 7188.
Entering Image File, Link file and Headings for an Image Placemark or Image Polygon
Image Files : The top, left hand drop down box, under the heading Click to Change Current Image,
selects the current Image holder. You are able to select up to 8 Images for an Image Placemark or
Image Polygon. The File selection box, on the right hand side of the form, will display all
acceptable Images in the current folder path. The folder path can be changed by selecting the
required path, using the Drive and Directory selection boxes above the file display. The Image
type displayed can be selected using the file Type selection box below the file display.
NB : The only Image file types that may be used are JPEG (*.jpg), Bitmap (*.bmp) or GIF (*.gif)
files.
Clicking on a file Name in the File selection box will display the image in the image holder at the
top centre of the form. To select this file as the Image for the Current Image, double click on the
file Name.
Image File Headings : Each Image used for an Image Placemark or Image Polygon can have its own
Heading. For example, for Image #1, position the cursor in the input box, directly below the
heading Image #1 Heading, enter the heading required for that Image. Repeat this for all Images
that are used.
Image Sizes : You can set the size of each Image included in the Placemark, or Polygon KML file.
Image width values may be selected from 75 pixels up to 600 pixels. The default value is 300
pixels. These are the sizes of the Images that will be shown when you click on a Placemark, or
Polygon in Google Earth. The actual size of the Image itself is not changed. Once in Google
Earth, you can right Click on a displayed Image in order to display it full size.
Placemark or Polygon General Headings : At the bottom left of the form are input boxes for up to 9
General Headings. These headings may be used for any descriptive purpose to help describe the
purpose, locality etc. of the Image Placemark or Image Polygon. These headings may be entered,
edited or removed in the usual way.
Placemark or Polygon Link Files : A Link File is a file that the Image Placemark or Image Polygon
can load up and display within Google Earth via a hyperlink text item.
NB : Link Files have to be Printer Document files (**.pdf) or standard ASCII files (*.txt).
The input boxes directly below the heading Placemark Link Files, or Polygon Link Files, at the
bottom centre of the form allow for the selection of up to 5 Link Files.
NB : For Image Polygons, SURPAC automatically generates and adds a text file that contains
the Polygon Points system co-ordinates, geographical co-ordinates, the distances and
directions, between Points and the Polygon Area. This file will automatically be included in
the KML file’s list of hyperlink Link Files. The file will not be shown on the above form, but
the hyperlink will be visible as a part of the KML file information in Google Earth.
On clicking on any of the available 5 input boxes for Link Files, The file selection box, on the right
hand side of the form, will display all **.pdf and **.txt files in the current folder path. The folder
path can be changed by selecting the required path, using the Drive and Directory selection
boxes above the file display. The Link File type displayed can be selected using the file Type
selection box below the file display.
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Double Click on a file Name in the File selection box to select this file as a Link File. The file’s
name will appear in the selected Link File input box.

Creating KML Image Polygons in SURPAC
Image polygons are created using the General CAD programme (found under the General Menu
heading).
When in the General CAD programme, move the mouse cursor inside the figure/stand/polygon for
which you want to create an Image Polygon on Google Earth. Then right Click the mouse. The
cursor will move up into the Menu area. Now Click the Figure menu heading and then, from the
drop down menu, select the option Create a Google Earth Image Polygon. NB : The keyboard
equivalent command is [FG]. With the cursor inside the required figure/stand/polygon, type in FG
You will now be prompted to enter the Number or Name for the figure/stand/polygon. The
programme will then for search and locate the Lines that form the figure/stand/polygon. These
Lines will be displayed in purple. If the incorrect Lines are selected, then cancel the routine
The form for selecting Image Files, Headings, Link Files etc. will be displayed If the incorrect
Lines figure/stand/polygon have been selected, then cancel the routine and retry.
Refer to the above explanations on how to
select information for the Image Polygon
KML
and
how
to
create
a
Combined_Image_Polygon KML.
Displaying an Image Polygon KML on
Google Earth : Once an Image Polygon has
been created, SURPAC will transfer the KML
file Google Earth (assuming that Google
Earth has been installed). You should see the
figure/stand/polygon shown on Google Earth
as a half-transparent cyan polygon. To display
the Polygon’s Name/Number, headings, Link
Files and Image Files, Click anywhere inside
this displayed polygon.
NB : The hyperlink Link File called *****__Data_File.txt (where ***** is the given
Name/Number for the Image Polygon) will
automatically be included in the list of Link
Files. This Link File consists of System and
Geographical co-ordinates for all the
polygon points, plus the polygon area.
To display the contents of a hyperlink Link
Files, right Click on the hyperlink. Google
Earth will then switch to its display page and
display the contents of the file. If the file does
not display and the loading bar stays on the
form, then just click the refresh button at the
top of the screen.
To display an Image in full size, right Click on
the Image. Google Earth will then switch to its
display page and display the full size Image.
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Creating Hatched (filled) Polygons for Exporting to Google Earth
Using the SURPAC General CAD programme, it is possible to create a KML Hatched Polygon file
and export it to Google Earth.
In the General CAD programme, Click the Hatch/Flood menu heading and then select the menu
items to set the required Hatch Colour and Hatch Type and then Hatch the selected Polygon.
From the File menu heading, select the item Create a KML Google Earth Image Polygon. Enter
the required Name for the Polygon and, when the Image and Link file option form is displayed, just
Click on the [Proceed] button.

Google Earth display of a Hatched (filled) Polygon from the General CAD programme
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